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Abstract

Diffuse is a finite difference computer program which maybe used to calculate the one-dimensional dfi-

sion and trapping of atoms in a host material under general initial, source, and boundary conditions.

Diffusewas originallywritten in Fortran prior to 1980, and rewritten in 1983 in order to run on the Sandia

Cray computers in use through the early 1990’s.When the mainfmme computers were retired, the Gas

Transfer System (GM) Development Department ported the code to the PC platform, where it ran as a sim-

ple console application. All graphical output was lost during this port. GM code developers have completed

an upgrade that provides a Whdows 95/NT Diffuse application and restores all of the original graphical out-

put. This upgrade is called DiffuseII version 1.0. This report serves both as a users manual for DiffuseII v
1.0and as a general softsvare development reference.
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Executive Summary

Diffuse is a finite difference computer program which maybe used to calculate the one-dimensional diffu-

sion and trapping of atoms in a host material under general initial, source, and boundary conditions.

Diffuse was originally written in Fortran prior to 1980, and rewritten in 1983 in order to run on the Sandia

Cray computers in use through the early 1990’s.When the mainframe computers were retired, the Gas

Transfer System (GTS) Development Department ported the code to the PC platform, where it ran as a sim-

ple console application. All graphical output was lost during this port. f3!3 code developers have completed

an upgrade that provides a Windows 95iNT Diffuse application and restores all of the original graphical out-

put. This upgrade is called Diffuse II version 1.0.

This report serves both as a user’s manual for Diffuse II v 1.0 and as a general software development refer-

ence. The intent of the software description is to help other developers understand the development philoso-

phy and software structure so that bugs maybe more easily eliminated and future upgrades maybe

simplified.

-“
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User’s Manual

Scope

This user’s manual is not intended as a comprehensive guide to the physical models implemented in the Dif-

fuse code. Model specific information can be found in the original DIFFUSE user’s manurd*. This manual

serves only to describe how to use the Whdows 95/NT Diffuse II upgrade.

Overview

Diffuse is a finite difference computer program which calculates the one-dimensional difksion and trapping

of atoms in different materials under general initial, source,and boundary conditions. Diffuse enablesthe

user to compute, singly or in combination:

1) bulk diffusion of one or two species in a multi-layer medium, including a temperature gradient, and

2) tritium decay resulting in trapped helium upon decay (i.e. no migration).

While the computational code supports trapping and detrapping, this version of the user interface, written

specifically for gas transfer applications, does not support the introduction of trap distributions. The inclu-

sion of trapping support would allow the code to be more broadly applicable and should be considered an

important upgrade for the next release.

The difising species may arise from

1) implantation

2) diatomic gas phase entry at surfaces, or

3) initial surface concentrations.

Simple geometries for which results may be computed raw

1) a semi-infinite slab,

2) an infinitely long solid or hollow cylinder, or

3) a solid or hollow sphere.

Code History

Diffuse was originally written in Fortran prior to 1980, and modified by M. Baskes in 1983 enabling it to

run on the Sandia Cray computers in use then and through the early 1990’s.The partial differential equations

of Fickian difksion were solved using a Sandla-written numerical solver. Diffuse ran kdkdly on CDC com-

puters, using cardfile inputs. Later, it ran on the Cray computers first under COS and then CTSS. The find

configuration used the VAX computers for input/output to the Cray computers. In this configuration, termi-

nal operation was available.

l.Baskes, M. I., DIFFUSE, Sandia National Laboratories, SAND83-8231, June 1983

7



In the mid- 1990’sthe Cray computers on which the code ran were relocated to Sandia/NM and over the next

few years became less and less accessible. Several responses were developed. Initially, Diffuse was incorpo-

rated into an integrated design-tool environment using a CORBA (Common Object Request Broker Archi-

tecture) wrapper. This activity was funded as a OTS pilot under the Product Realization program, but ended

with no plans or funding to maintain the design tool environment. When the mainframe computers were

finally retired, ~S Development Department ported the code to the PC platform, where it ran as a console

application. Unfortunately, because the Diffuse plotting routines required a graphics library that was not

available for the PC platform, all graphical output was lost, During this upgrade, the console application was

converted to a Windows 95/NT application with a modern user-interface and all graphical output was

restored.

b

.
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Installation

Although Diffuse is intended to be installed on only a limited number of machines, an automated installation

program was developed to automate installation onto a Windows 95/NT computer. The instrdlation program,

Di@seSetup.exe, was created with InstallShield Express 2. The program copies the required files to the

appropriate directories on the selected hard drive, makes required registry updates, and creates program

groups and menu items.

Run DiffuseII by double-clicking the Dij’ivin.exe icon or an appropriate shortcut or by selecting the Dift%h

menu item from the Start menu.

9
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Diffuse Display

The Diffuse II display is shown in Figure 1. The DiffuseII main frame, which also displays the name of the

currently selected document in its title bar, houses the system menu, toolbar, and main output window. The

main output window contains a single graph that displays calculation results in plot form. The Di@.se Input

tabbed dialog, also called a property sheet, provides the user with the means to enter the problem definition.

Unlike the main output window, the tabbed dialog is not constrained to remain within the main frame bound-

aries. It can be moved to any desired location on the screen.

Diffuse II allows the user to manipulate multiple sessions (documents) at the same time, a capability that is

useful when comparing several different problems. Selecting New from the File menu starts an addkional

session and presents an additional main output window and its contained graph. The number of concurrent

sessions is limited only by the amount of available memory and the user’s ability to maintain an understand-

ing of the multiple windows. Although multiple main output windows may be displayed, only a single input

tabbed dialog window is shown. The values in the tabbed dialog always correspond to the currently selected

main output window.

Data from a Diffuse II session maybe stored by selecting Save or Save As from the File menu. If the data

has not yet been saved or if Save As is selected, the system presents the Save As dialog that allows the user to

Tm@&5!? -- ------- ., ~ , ~~ .
—... ., :+,,,”
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select a file name and location for storage. Selecting Open from the File menu restores saved data. In this

case the system presents the Open diaIog that allows the user to browse for the desired file. Plot data in the

main output window may be previewed or printed by selecting Pn”ntPreview or Print from the File menu.

Only the problem definition data (i.e., the data contained in the three pages of the input tabbed dialog -- see

“Input Tabbed Dialog” on page 12) is saved. When reading data from an existing file, the user must click the

Cafculate button to recreate the problem solution data.

The next two manual sections describe the input tabbed dialog and the main output window in more detail.



Input Tabbed Dialog

The tabbed dialog is used to enter information that defines the problem to be analyzed and is initialized with

default parameters appropriate for a single layer of stainless steel subjected to a tritium gas pressure on one

side while the other is held at zero concentration. The input tabbed dialog contains three pages, each

accessed by clicking the appropriate tab. The first page defines the material sample, the second page defines

program control parameters, and the third page defines the environment and boundary conditions.

Sample Page

The Sample page, shown in Figure 2, allows the user define the material sample to be evaluated. In general,

the sample is a composite of a maximum of five individual layers of different materials. The number of lay-

ers in the sample of interest is selected in the No. of Samples list box. General geometric data is entered in

the second section of general sample data. A planar, cylindrical, or spherical sample geometry maybe

selected from the Shape list box. The vahre entered in the Inside Radius edit box applies, of course, only to

cylindrical and spherical geometries. The individual layer thickness is entered in the Thickness edit box

while the distance of interest into the overall composite sample is entered into the ProjWeedit box. The pro-

file distance value determines the distance scale for plotting and allows the user to focus the concentration

plot results on the near surface area of interest. For convenience, the profile value maybe quickly set to the

composite thickness by clicking the max button.

12
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The identity of the gas(es) to which the composite sample is subjected is defined in the Dij%sing Species

data section. The number of species, which is limited to a maximum of two, is selected in the No. Species list

box while the individual gases are identified by the selections in the Species 1 and Species 2 list boxes.

The material properties and boundary conditions for the individual layers are

defined in the right side of the Sample Page. The layer for which properties are

to be defined is selected in the Sample Number list box, the upper limit of which

is determined by the No. of Samples value. For convenience, entire data sets for

the common materials shown in Table 1, maybe entered by selecting the

desired material in the Mat’1Name list box. Individual property values,

described in Table 2. may be overridden by simply entering the desired value in

the appropriate box. Because this version of DiffuseII does retrieve material

information from a database, the new data set cannot be stored under the same

or different material name. However, saving the problem data file, as later

described, does save all user entered data.

The interface boundary conditions for each layer are defined in the Boundary

Conditions section of the Sample Page. The available interface options are

shown in Table 3. Note that all interior interfaces should use the Zrzterjface

boundary condition “

Clicking the Calculate button initiates a Diffuse II calculation and, if success-

ful, updates the output in the main window.

Table X Material Properties

Table 1: Available
Materials

Aluminum

Beryllium

Carbon

Copper

Inconel

Iron

Molybdenum

Nickel

Steinlese Steel

Titanium

Tungsten

Vanadium

Zirconium

Ed eV Activationenthalpy for dtiusion

DO cm2 amu% /sac Pre-exponentisl constant for diffusion

Es eV Activationenergy for volubility

so afrac / atm% Pre-exponential constant for volubility

Density atoms / cm3 Atomic packing density for the host matrix

Q-star eV Heat of transport for the diffusing species

Stick Sticking coefficientfor adsorption from gas (Oto 1)

Table 3: Bonndary Conditions

Reflection The boundary reflects all diffusingspecies

Zero Cone. Diffusingspecies concentration is zero at the boundary

Seivert’s Law Concentration is proportional to the square root of pressure

Recombination Diffusingspecies must recombine at the boundary according to a rate equation
with a rate constant determined by other the other user-defined parameters

Interface Specifies an internal layer interface’
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Control Page

The Control page is shown in Figure 3. Here the user enters information that controls execution of the com- .

mutational part of Diffuse II. During the computation, the composite sample is divided into a one-dimen-

sional mesh with a number of nodes equal to the value entered in the Number of mesh nodes edit box.
.

Although this version of Diffuse II does not use the Number of-cycle repeats value, the edit box is included

to simplify its inclusion into the next release.The Number of cycle repeats defines the number of times that

the sequence of steps defined in the Data page is repeated.

The remaining control parameters allow the user to determine the relative distribution of mesh points

throughout the material layers so that large concentration gradients maybe appropriately represented. The

values in these edit boxes are evaluated in a relative, not absolute, manner. A layer with a larger value

receives a proportionally greater number of mesh nodes. If all values are equal, the mesh nodes are uni-

formly distributed.

II
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Data Page

The Data page, shown in Figure 4, allows the user to enter information describing a series of pressure and

temperature boundary conditions to which the composite sample is subjected. The value in the Number of

DATAcards list box determines the number of steps in the boundruy condition sequence and is limited to a

maximum of five. The individual steps maybe selected for data entry or review by selecting the appropriate

card number from the Card Number list box. The i’ime interval edit box contains the time step for the

selected card. The Number ofprhzt edits list box is not used by this version of Diffuse II.

The pressure boundmy conditions for each of the gas species identified in the Sample page are defined in the

Pressures section of the page. Here, values are entered for each species and for the front and back sides of

the composite sample. Note that if only one species is selected in the sample page, the species 2 edit boxes

are grayed and cannot be accessed. Each pressure boundary condition is specified by two values, an initial

value and a ramp (Ap/time). By entering appropriate values in these edit boxes for each data card, the user

may specifj a piecewise linear approximation to a continuous time-varying pressure condition. Note that

DiffuseII does not calculate the pressure increase due to tritium decay in a closed volume. To model such a

case, the user must calculate the tritium partial pressure time history, decompose it to a piecewise linear

approximation, and enter the appropriate initial and ramp values for each data card.

Temperatures may be specified for each side of the individual material layers that comprise the composite

sample. Similar to the case with the pressure boundary conditions, only those edit boxes associated with

defined material layers from the Sample page are enabled for user input. Also similar is the fact that each

-.
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Figure 4: The Dati page of the Di@e Input tabbed dialog
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temperature is defined by two values, an initial value (K) and a ramp (K/see). By entering appropriate values

in these edit boxes for each data card, the user may specify a piecewise linear approximation to a continuous

time-varying temperature condition. Note that Diffuse H interprets temperature values of zero as being equal

to the value from the previous layer. Therefore, to enter a uniform time-invtiant temperature condhion, the

user need only enter the desired temperature in the upper left edit box while ensuring that all other values are

zero. Diffuse II does not calculate temperature increases due to tritium self-heating,

Main Output Window

The main output window, as shown in Figure 5, contains a graph window for each

open document. The graph window provides access to plots that display species

concentration profiles, species release rates, or species release integrals. In addi-

tion, each plot contains an individual curve for each data card that is defined. The

curves are identified by the legend above the graph. When the user clicks any-

where in a graph pane it becomes active and therefore the target of all plot related

toolbar and menu commands. The Viewmenu, shown in Figure 6, allows the user

to select the plot type for display. The available plots types are described in Table

4. Each plot type holds several different plots; the exact number is dependent

I -_ -. “ -
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! .’,-,’*’-
i “.”?- ~ “’-””” ‘

I“3
1000~

!“y,
, ;:8 .

I .500

, ,.:--,. -.

., ., -..
I

... ,,. ,
i :., -0, “ “ ‘ 0.00

! $8fi.oa 0,.,.

Figure 6: View menu
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Table 4: Available P1ot Types

Concentration Diffusing species 1 (DSI) Species (or sum) concentration as a function of
profile di&ance into the composite sample

Release Rate

Release inte-
gral

Decay product 1 (DP1)
Sum (DS1 + DP1)
Diffusing species 2 (DS2)
Decay product 2 (DP2)
Sum (DS2 + DP2)
Sum (DS1 + DS2)

Diffusing species 1 (front)
Diffusing species 1 (back)
Diffusing species 2 (front)
Diffusing species 2 (back)

Diffusing species 1 (front)
Diffusing species 1 (back)
Diffusing species 2 (front)
Diffusing species 2 (back)

Rate of release of sgecies from either the front
or back surface of the composite sample. Neg-
ative value is into the material.

Rate of release of species from either the front
or back surface of the composite sample. Neg-
ative value is into the material.

Tabbed dialog
visibility button

~:!File Edit View Window Qptions Help

K!IZIBl i- Imam lEElISEZL]I

Plot type buttons Plot scroll buttons

Figure % Toolbar

upon the number of species defined. As an alternative to using the View menu for selecting plot type, the

user may click one of the three plot type buttons on the toolbar, as shown in Figure 7. The plot scroll buttons

allow the user to scroll forwards or backwards through the list of available plots. An additional toolbar but-

ton, the Tabbed Dialog Vkibility button, allows the user to alternately show and hide the tabbed dialog.

Right-clicking on the graph reveals the Graph Control property pages, as shown in Figure 8, and allows the

user to interactively change the graph’s appearance. The large number of available pages provides access to

almost all graph characteristics. Note, however, that changes made to one graph affect all others.



Figure 8: Graph Control property pages

Figure 9: Option menu

Miscellaneous Options

The Option menu, shown in Figure 9, allows the user to select numerical units for entered and displayed

time and pressure quantities. This option permits the entry of understandable numerical values for the prob-

lem of interest. Available time units include seconds, days, months, and years while available pressure units

include atmospheres and pound per square inch (psi).

18
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Viewing the Input and Output Files

The files input to and written by the Diffuse II computational program can be viewed by selecting the

desired item from the final two presented in the V7ewmenu. The user may select either the last generated

(current) input file or currently selected plot data file. Because each calculation overwrites the files gener-

ated during the previous calculation, only the most recent file sets are available. This version of Diffuse It

includes an integral fde viewer that is aware of data changes made by the user. Once a calculation is per-

formed, the new data is automatically displayed in the open viewer.

Input File

The input fde, indi$dat, is a Fortran namelist for-

matted text file read by the Diffuse II computat-

ional program. It maybe viewed by selecting Lust

Input File from the Wewmenu. Diffuse II then

starts the data viewer and loads the last input file

generated. This simple viewer only allows the dis-

played contents to be written to a file or copied into

a buffer for later pasting into another application.

A sample display is shown in Figure 10. Reference

1 provides a detailed description of each of the

namelist variables.

Plot Data File

The plot data files are formatted text files that con-

tain the numerical data used to generate the plots in

the graph display. The data used to generate the

currently selected plot may be displayed by select-

ing Last Plot Data t%omthe T&wmenu. Diffuse II

then starts the data viewer and loads the last plot

file generated for the selected plot ~pe. A sample

display is shown in Figure 11.When more than one

data card has been created during problem defini-

tion, selecting this menu option displays the data

card selection dialog shown in Figure 12. Here the

user selects the desired data card number from the

list box. Clicking the OK button the displays the

requested data.

% Ed

$sample
igenn=2.
rO=2.54,
profile=O.1,
tritiw=. T..
idiff=2.
&&i3:” 2,
length=O.1,
fmnt=2,
IJack”l.
mat=*aE ‘,
ED=O.559.
DO= O.0047.
ES= O.0607,
SO=O.00079.
DEN=8.5ei022,
QSTAR=-O.065,
STICK=O.

%ld
$Control

MdeS=loo.
Ilc@es= 0.
npmntc= 1.
fimp=O.25,
faat=l.

Send
$data

nprint=l,
cprint=.T. .
nplot=3.
ptype=’mn’. ‘rate’.‘int’.
ya8is=’al1’:’all’.’al:’:
xasis=’pmfzle’. ‘time’. tine’,
nemun=. T.,
time=3,15576e+O07.
tE6iDo=~13. O.
rania=o. 0:
PO=340.229. 340.229. 340.229.
Palm+). 0. 0, 0.

$end

T .-.(.[ —-—-———------------------ -- - - %-:W..’+---a_Y-_. ..* .

Figure 10: Sample input me
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con Drufi all

C2 (all)

...... .. ... ..

..,HMWX. .~ -&-.-*<-dJ””””. ,w8Lab.t8kEifHh* U. . . “ . %’ ., .,~’

‘g ~
nsets= 7
Profile
Concantration. Cl.

0. O%%ti
c11 C12 C13

1.0415E-03
C21

5.2441E-05
1.020.4E-03

1.0939E-03
9.6569E-04 5.2441E-05

1.1OI6E-O3 ;,

3.0612E-03
1.0181)3-03 1.0297E-03

8.1725E-04 4.0868E-05
5.102OE-O3

8.5812E-04 8.8840E-04
6.7891E-04 3.1640E-OS

7.1429E-03
7.1055E-O4 7.5500E-04 1 ,

5.5479E-04 2.4355E-05
9.183?E-03

S.7914E-O.4
4.4695E-04

6.3295E-04
1.86S2E-05

1.1224E-02
4.6S60E-04

3,S571E-04
5.2428E-04

1.4222E-05
,

1.3265E-02 2.8018E-04
3.6993II-o4

1.0802E-OS
4.2974?3-04 :

1.5306E-02
2.9099E-04

2.1876E-04
3.4907%04

8.1774E-06
1.7347E-02 1.69S4E-04

2.2694E-04 2.8133E-04
6.1722E-06

1.9388E-02
1.7571E-04

1.30S6E-04
2.2621E-04 ;

4.6469E-06
2.1429E-02

1.36’20E-04
9.9997E-OS 3.4907E-06

1.7924E-04

2.3469E-02 7.6237E-05
1,0349E-04 1.4194E-04 , ;

2.6171E-06
2.5S1OE-O2

7.8854E-05 1.1191E-04
S.7892E-OS 1.9589E-06

2.7551E-02
5.98S1E-OS 8.7904E-05
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Figure 11: Example plot data file

Figure 12: The Data Card selection dialog

.

.

L

.

The plot data file concentration, release rate, and release integral columns are labeled with a subscripted

alphabetic code, where c = concentration, yr = release rate, and yi = release integral. The first subscript

refers to the species number while the second refers to the diffusing species itself(1), its decay product (2),

or the sum of the two (3).
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Miscellaneous

Code Lhnitations

Diffuse II currently performs only minimal input value checks. As a resul~ if the user errs when entering

values, the Diffuse computational routiries may receive data that is not completely appropriate. Depending

upon the nature of the error, the computation may complete and provide erroneous output data that can gen-

erally be identified in the output plots. On the other hand, certain input errors may result in more dramatic

responses, If the calculation does not complete in a short amount of time, the user can open the computa-

tional message output window by clicking on the DiffuseSG2 button on the taslcbar. If the calculation is

experiencing difficulty, a message maybe displayed in this window. Note that the taskbrwbutton is available

only while the computational routines are executing. While future versions of Diffuse II may implement a

more complete input-checking algorithm, the current version places the responsibility for ensuring consis-

tent input primarily upon the user.
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Software Description

This section briefly describes the Diffuse II softwwe development philosophy and structure. The intent of

recording this information is to provide future developers with the basis needed for code debugging or

upgrading.

Development Environment

The Diffuse II upgrade was developed on a Windows NT PC using the Microsoft VksualStudio integrated

development environment (IDE)*. Visual Studio provides an environment that enables a developer to effi-

ciently write, test, and debug code. All C and C++ code was compiled with Microsoft’s Visual C++ 6.0 comp-

iler while the For@anwas compiled with Digital Vkual Fortran 5.0 compiled.

Code Structure

Diffuse II conmins three executable files, DijWin.exe, Diffsub2SGexe, and Sgw32.exe. DiffT$5n.exeis the

executable image created by compiling and linking the C++ user interface code while Diffsub2SGexe is the

image created by compiling and linking the Fortran computational code. Sge32.exe is a local automation

server that produces tie plots in the graph pane of the main output window, The user runs Diffuse II by exe-

cuting the interface image. When the Calculate button is clicked, the user interface runs the computational

code by spawning a new synchronous process. Once the computational code terminates, @e system destroys

that process and returns control to the interface code. With this structure, the interface and computational

codes run in separate process spaces and do not share memory.

The described structure ww selected for one primary reason, The original Fortran Diffuse console applica-

tion, from which the computational code was derived, used very little interactive user input. Rather, all

important inputs were provided in a namelist formatted text fde. Additionally, the code wrote all important

output data to similar text files. This file I/O configuration of the ofiginal Diffuse provided a simple means

of file-based communication between tile interface and computational codes and required a minimum of

Fortran source modification. indijdat is the input file written by the interface while difitxt and difkg* (* = 1

to 15) are the summary report and plot data files written by the computational routines.

Computational Code

As previously mentioned, the finished computational code is a minimal modification of the original Fortran

1. Microsoft Corporation, One Microsoft Way, Redmond, Washington 98052-6399, M
www.m~crosoft.com
2. Digital Equipment Corporation, Maynwd, Massachusetts, ~ttp://www.dec.com

.
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Diffuse application and is itself an executable application. The modifications, which are documented in the

source code, include minor syntactic changes to access the Visual For&an QuickWln run-time library, which

adds some windowing capabilities to the application. These statements prevent the application from display-

ing a window when it executes. Rather, the application window is minimized and is visible only as a taskbar

button. While it is active, however, the user may click the button to expand the window. The computational

segment was built as a Standard Graphics application using the Visual Studio 97 AppWlzxd. A Standard

Graphics configuration was chosen because it supports the QuickWh Iibrmy routines and allows the win-

dow to be minimized at execution.

When it executes, the code expects to find a namelist formatted text file called indifdat in the same directory

defined by the DIFFDIR registry variable. If the file is not presen~ the code will not execute successfully.

During execution, the code writes several files: di@zt, which contains text-based summary repom difplt,

the summary plot file, and the individual plot files. The number of individual plot files is determined by the

number of data cards identified in the problem definition. The generic individual plot file name is difkg*,

where * is an integer between 1 and 15. The file number is given by:

file number = 3(card number – 1) + graphnumber+ 1

where card number = the data card number selected by the user (1 through 5) and graph number= Ofor con-

centration plots, 1 for release rate plots, and 2 for release integral plots.

User Interface Code

The user interface code, written in C++, was built using Visual Studio’s MFC (Microsoft Foundation Class)”

AppWlzard as a MDI (multiple document interface) application. The Microsoft Foundation Classes provide

object-oriented wrappers around most of the Windows 95/NT API (application programming interface) rou-

tines while the MDI architecture allows a user to concurrently work on several Diffuse II documents. The

finished interface code comprises many classes, some of which were generated by the Appwlzard, most of

which were developer-generated, and some of which were generated by the inclusion of software compo-

nents. The classes are summarized in Table 5. Some of the more interesting classes are described in more

detail below.

Property Sheet and Page Classes

The prope~ sheet is the tabbed dklog that contains each of the three property pages. Although the user

enters data in these pages, it is stored communally in the document object. The MFC UpdataData( ) state-

ment transfers data to and from the property page edt and list boxes and the dkdog class member variables.

TWOdialog class member functions, SetMemberData( ) and SetDocumentData( ], transfer data between the

corresponding dialog and document member variables.

Each page is responsible for maintaining its own display. Display maintenance includes routine tasks such as
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Table 5: Important Classes

CAboutDialog The About Diffuse dialog class. This dialog is displayed from the Help

CChildFrame

CControlDlg

CDataDlg

CDiffMsgDlg

CDiffWinApp

CDiffWinDoc

CDiffWinView

CGetDCDlg

CGraph

ClnputPropSheet

CMainFrame

CSampieDlg

CSplashDlg

CSplashThread

menu.

The child frame window class.

The Control dialog (property page) class

The Data dialog (property page) class

The calculation animation dialog class

The application class

The document class

The view class

A dialog class that allows the user to select a data card number when view-
ing plot data

The graph class

The input tabbed dialog (property sheet) class

The applications main output frame window class.

The Sample dalog (properly page) class

The splash screen dialog class

A thread class used for the splash screen display

filling the edh boxes with appropriate values, enabling and disabling vwious controls, and storing edit box

data to the member variables.

Document Class

The document objec~ represented by the CDijjWinDoc class, stores all of @e data required for creating the

computational routine input file, indif dat. Itwrites this file once itisinstructedtoinitiatea calculation.It

then spawns the computational process, reads the resulting data from the appropriate disk files, and updates

the graph. The document is also responsible for serializing all of its data and therefore implements all file

input and output. A simple schema number written to the data file provides version control for future bac!c-

ward compatibility.

View Class

The view class, CDz~nVew, contains a single CGraph (provided by a purchased software component

called Graph Control. 1, object that fiils its client window. This graph is loaded with data and redrawn in

respmse to user requests via the menu or toolba.r items or in response to an updated calculation.
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Data Viewer Class

As previously mentioned, this version of Diffuse II uses an integral data viewer to display the contents of the

input and output files. This functionality is implemented in the CDataWewerDlg class and is currentlylim-

ited to data display, serialization to a file, and data copy to a buffer. Although no viewer printing support is

yet provided, the copy ability allows the user to transfer the data to another application, such as NotePad,

and then print. The viewer is able to receive an Updatelnfo( ) command, generally sent by the document

after it has completed a calculation, and fill the viewer with the latest data. Adding direct print capability to

the CDataVlewerDlg class is a desirable upgrade.
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